Example of a List of Figures

Figure 1: MISCHYSHYN, J., 2012. Galway — River Corrib from Wolfe Tone Bridge
[photograph]. Available from: http://www.geograph.ie/photo/2027197 [Viewed
28 April 2015].

Figure 2: MONET, C., 1872-73. Pleasure Boats, Argenteuil [oil on canvas]. Available
from: http://www.wikiart.org/en/claude-monet/pleasure-boats-argenteuil-c-1872
-3-oil-on-canvas. [Viewed 28 April 2015].

Figure 3: LUFT, J., 1970. The Johari Window [fig.]. In: MULLINS, L.J., 2010.
Management & Organisational Behaviour. 9" ed. Harlow: Pearson Education.

Figure 4: ANDERSON, C.M. & UCHIDA, H., 2014. Interface for individual quota-
managed subject in mixed treatment [graph]. In: Economic Inquiry, 52 (2), April,
p. 906.

Further Information

Further examples on using figures and tables are available on the ATU
libraries website:

° Harvard Style: https://libguides.gmit.ie/harvard/
citing_images_figures_and_tables.

o APA style (6th edition): https://libguides.gmit.ie/APA_Style/
citing_images_figures_and_tables

o Copyright: https://libguides.gmit.ie/copyright/
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When writing your assignments or theses, sometimes you will want to use tables
or images to illustrate your work. Every time you borrow a picture, painting,
photograph, diagram or other image from a source, you must acknowledge
where you got it from. This guide will show you how to reference figures and
tables using the Harvard Reference Style (further examples are available at
https://libguides.gmit.ie/harvard). For examples in APA 6th edition, please see
https://libguides.gmit.ie/APA_Style.

Copyright:

When re-using images, diagrams, graphs or tables created by others, from either a
printed or an internet source, they are usually protected by copyright. This will be
stated on the image itself or nearby in the text. Often reproduction for use in
academic assignments, which are not formally published, is acceptable. If in
doubt, ask your lecturer.

To find copyright free images, try using a royalty free image site or the Wikimedia
Commons search engine https://commons.wikimedia.org/wiki/Main_Page.
Always check the author's terms of use to see if permission is granted. If the
author does not state any terms of use, then assume that the item is protected by
copyright and you will need permission from the creators to use it.

Reproduction of tables, diagrams, pictures etc. should be treated as direct
quotes, in that the author(s) should be acknowledged and page numbers shown
both in your text where the diagram is discussed or introduced and in the
caption you write for it. i.e. the author(s) is alluded to 3 times:

1. In a caption, just above or below the image or table. This includes a title and
its source. Figure captions go below the figure and Table captions go above
the table in the Harvard Reference Style.

2. Inyour text. Include a citation and a sentence or more about the image or
table explaining what it exemplifies and why it is there.

3. As areference in your Bibliography or Reference List.

If you are writing a thesis, you will need to show a List of Figures immediately
after the Table of Contents. They should appear in consecutive order, as they are
referred to in the text, and have clear, concise titles. If you have only used a few

images, you can include the details of the figures in your Reference list.
©2022 ATU Libraries 2

Figure and Table References using Microsoft Word

After a Table of Contents, most theses also include a List of Tables and a
List of Figures. To make compiling this list less difficult, you can use a
specific kind of label each time you insert tables and figures that will allow
you to generate the list automatically in Word.

How to create a Figure Caption or Table Title

1. Go to the figure or table you want to | Caption 7 X

reference. Caption:
IFu‘gureI I |

2. Place the cursor where you want to optene

put a figure caption or table title. Lefocd: M -

Position: |Below selected item ~
3. Click on the 'References' tab and click | gude tabei from caption
'Insert Caption'. A window should Mewlabel.. | | Delete label | | Numbering..
open. :
AutoCaption... oK Cancel

4. Type in a caption or title.
5. In the 'Label' menu, choose 'Figure' or 'Table'.

6. You may choose to number the tables/figures sequentially or select
‘Include chapter number’ by clicking on the ‘Numbering’ button . (If you
choose to number your tables/figures by chapter, you must use
“Multilevel list” on the Home tab of Word to number your chapters).

Create a list

Once your figures and tables have been captioned, inserting a list is very
similar to how you created a Table of Contents.

With the cursor at the point where you want to insert the list:
1. Click the ‘References’ tab

2. Click ‘Insert table of figures’

3. Select a caption label (table or figure). Click ‘OK’.
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Online Images and Copyright

This includes any image from a website (photograph, diagram, illustration, table,
figure, etc.). Be careful when using Google Images as many of the images there
are subject to copyright restrictions and are not free to use. All images on the
Internet are governed by copyright law and it is your responsibility to find the
copyright permissions for each image you use.

To obtain images with Creative Commons licenses, proceed as follows:

1. Go to the Google Images search bar.
2. Type in your search term and then click on ‘Tools’ and ‘Usage Rights’.
3. Select ‘Creative Commons Licenses’. These steps will filter out as many

copyrighted images as possible.

4, When you find an image you might use, go to the source website for the
image.
5. Look on the source page for information about the copyright license for

that image and any author who may need to be cited.

6. If the image is copyrighted by Creative Commons, you may use it. If
copyrighted by any other author, you may not use it.

7. Create a copyright statement and references list citation for the image.

Sources of Copyright - free Images
. Creative Commons (CC) search

. Unsplash

. Freepik

. Pixabay

. Wikimedia Commons

. Flickr Creative Commons
. Free stock photo websites
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Referencing Figures from Printed Material

You should provide a caption, an in-text citation for any photographs,
images, tables, diagrams, graphs, figures or illustrations that you
reproduce in your work and provide a full reference as with any other type
of work.

[Caption] Figure 6: Figure and ground (Source: Mullins, 2010, p. 219).
Reproduced with permission from Pearson Education Ltd.

Caption under Figure from a Book with Copyright Permission

Figure X: Descriptive title of the Figure. (Source: Author, Year, page number).
Reproduced [or adapted] with permission from Name of Copyright Holder OR In
the Public domain OR Creative Commons attribution (e.g. CC BY-NC).

N.B. Copyright permission may not be required for student theses, unless
they will be subsequently published online. Please check with your lecturer.

Put the full reference for the above in your Reference List or List of Figures.

MULLINS, L.J., 2010. ‘Figure and Ground’ [illus.]. In: Management &
Organisational Behaviour. 9th ed. Harlow: Financial Times Prentice Hall,
p. 219.



Reproduction of Figure from a book

TIERNAN, S. & MORLEY, M.J., 2013. ‘Maslow’s Hierarchy of Needs’ [fig.]. In:
Modern Management: theory and practice for students in Ireland. 4™ ed. Dublin:
Gill and Macmillan, p. 23.

Reproduction of Artwork in a Book

For the reproduction of artwork, the details of the person responsible for the
reproduction and the details of the book should also be included:

RUNGE, P.O., 1805-06. ‘The Hulsenbeck children’ [painting]. In: BARTRUM, G.
(ed.), 2011. German Romantic prints and drawings: from an English private
collection. London: Contemporary Editions, p.27.

Reproduction of Photograph within a book

If the photograph is within a book, the details of the photographer and the book
should also be included and the page number:

EDGERTON, H., 1957. ‘Milk drop coronet’ [photograph]. In: THOMAS, A., 1998.
Beauty of Another Order: Photography in Science. New Haven: Yale University
Press, p. 183.

Reproduction of lllustration within a book

MORRISSEY, T., 2000. Life in nineteenth century Wexford [illus.]. Dublin:
Macmillan, p. 645.

Maps and other cartographic material

If possible, details of a map should include the originator/author (if stated on the
publication), the date, the title and scale of the map (e.g. 1:50,000) and the Place
and Publisher:

ORDNANCE SURVEY, 1999. Munster by road, 21. 1:50000, Dublin: Ordnance
Survey (Discovery series).
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Table 7.1 Purpose of Saving
% of households

Purpose of saving

Provision for unexpected events 59.8
Old-age provision 381
Travels/holidays 315
Education/support of children or grandchildren or other ralatives 311
Qther major purchasas (other residences, vehicles, furniture, etc.) 20.6
Purchase own home 18.1
Paying off debts 9.8

(Source: Central Statistics Office 2020)

In-Text: Table 7.1 (Central Statistics Office 2020) indicates that...

Reference: CENTRAL STATISTICS OFFICE, 2020. Saving. Available from: https://
www.cso.ie/en/releasesandpublications/ep/p-hfcs/
householdfinanceandconsumptionsurvey2020/saving/ [Viewed 24 May 2022].

Refer to tables in-text

¢ Make specific reference to each table. Do not assume that the reader
will make the necessary connection between the text and the table.
Write something about each table.

Ex: Each sample tested positive for the three nutrients (see Table 2).
e Refer to each table in the text by its number (e.g. Table 5).

¢ Remember to guide the reader in interpreting the information in the
table. What does the table show? What specific point are you making?

Secondary Source

If the source of the data is not the author’s own, but obtained from
another source, it needs to be cited as such:

In-text: Thomsett (2002, p. 92) shows a table from the American Management
Association on how to estimate project hours (see Table 12).

Reference: THOMSETT, M.C., 2002. The little black book of project management.
2nd ed. New York: AMACOM.



Reference:
Artist name, Year. Title [Digital collage]. Available from: URL [Viewed date].

COSTA-MAURI, M., 2020. Fine Art, Digital Collage [Digital collage].
Available from: https://pixabay.com/illustrations/fine-art-digital-collage-
5333908/ [Viewed 23 May 2022].

Online images of works of art

If you see the work of art online, reference it like a website and include the
type of work it is after the title.

LAHART, N., 2010. Goya's Gaia #16 [Acrylic on board]. Available from:
https://imma.ie/collection/goyas-gaia-16/ [Viewed 23 May 2022].

Referencing Tables

Tables must be identified with the word "Table" and include a title and

source. As with figures, there are 3 elements to include:
1. Caption

2. In-text sentence referring to the table by number

3. Reference in the Reference List

If you are writing a thesis with a lot of tables, they should be referenced
in a List of Tables. In a shorter assighnment, where you might have
included only one or two tables, you can reference them in your
bibliography or reference list.

For a table, the number and title by which it can be identified are written
above the fields of data. However, the actual source citation is placed

beneath the table in the same way as a graph or figure.
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Caption under a Figure from a Journal Article

Figure X. Descriptive title of the Figure. (Source: Author, Year, page number).

Reproduced [or adapted] with permission from the Name of Copyright Holder
OR In the Public domain OR Creative Commons attribution (e.g. CC BY-NC).

Figure 1: The effect of brand emotionality on brand status inferences. (Source:
Lee 2021, p. 1183).

In-Text citation

Include a citation and a sentence or more about the image or table
explaining what it exemplifies and why it is there.

Lee (2021) shows a conceptual model (see Figure 1) to illustrate how emotional

content in social media influences brand status.

Reference List:

When referencing figures that come from articles, it is perfectly acceptable to
cite the parent article. If you want to specifically cite the figure or image, use
the article citation and make the following changes:

1.

Check the article content for additional source information
(e.g. photographer).

If the image has a title or caption, use that in addition to the article title.

Insert the image type (Chart, Diagram, Graph, lllustration, Map, or
Photograph).

Replace the page range of the article with the page number for the
image.

LEE, J. K., 2021. The effect of brand emotionality on brand status inferences
[fig.]. In: 'Emotional Expressions and Brand Status'. Journal of Marketing
Research, 58 (6), p. 1183.



Referencing Images appearing Online Photographs in Online collections

If you would like to reference images obtained from social media sites such as
Flickr, Pinterest or Tumblr, you can reference them by quoting the url for the site.

e Photographer

e Year of publication

e Title of photograph (in italics)
e Available from: URL

e [Date of access]

Example: Flickr

WHIDOMS88, 2021. The Wild Atlantic Way. Available from: https://
www.flickr.com/photos/102739648 @N03/51273207115 [Viewed 23 May 2022].

[Caption:] Figure 2: Atlantic Puffin (Source: Schindler 2018)

Text: Figure 2 shows a photograph of an Atlantic puffin in full flight Digital Collages

(Schindler 2018). A digital collage is created by layering together virtual images from
various sources into a new piece of art.

Reference:

e Photographer/Artist’s name

e Year the image or photo was taken/posted online

e Title of image or photo (in italics)

e [Type of image]

e Available from: website address

e [Date of access]

SCHINDLER, C., 2018. Atlantic Puffin [photograph]. Available from: https://
pixabay.com/photos/atlantic-puffin-bird-savage-puffin-3786563/ [Viewed
23 May 2022].

[Caption:] Figure 3: Fine art digital collage (Source: Costa-Mauri 2020)
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